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DS33M33 Demo Kit

General Description 

The DS33M33 demo kit (DK) is an easy-to-use 
evaluation board for the DS33M33 and the DS33M33 
Ethernet-over-SONET/SDH devices. The demo kit 
contains an option for either T3 or E3. The T3E3 links 
are complete with line interface, transformers, and 
network connections. Maxim’s ChipView software is 
provided with the demo kit, giving point-and-click 
access to configuration and status registers from a 

Windows®-based_PC. On-board LEDs indicate 
receive loss-of-signal, queue overflow, Ethernet link, 
Tx/Rx, and interrupt status. 

Windows is a registered trademark of Microsoft Corp. 

Demo Kit Contents 

DS33M33DK Board 
CD Including: 

ChipView Software 
DS33M33 Definition Files 
DS33M33DK Definition File 
DS33M33DK Data Sheet 
DS33M33 Data Sheet 

Features 

♦ Demonstrates Key Functions of DS33M33 
Ethernet Transport Chipset 

♦ Includes Ethernet PHY Supporting 10/100 and 
Gigabit Modes 

♦ Includes Optical SFP Module for SONET/SDH 
Interface 

♦ Network Connectors, Transformers, and 
Termination Ease Connectivity 

♦ Careful Layout Provides Signal Integrity 

♦ On-Board Processor and ChipView Software 
Provide Point-and-Click Access to the 
DS33M33 and DS3154 Register Set 

♦ Software-Controlled (Register Mapped) 
Configuration Switches Facilitate Clock and 
Signal Routing 

♦ All System Side and Overhead Pins are Easily 
Accessible for External Data Source/Sink 

♦ LEDs Programmed Through GPIO Pins 
Provide Status 

♦ Easy-to-Read Silkscreen Labels Identify the 
Signals Associated with All Connectors, 
Jumpers, and LEDs 

Ordering Information 

PART TYPE 

DS33M33DK Demo Kit for DS33M33 

 

________________________________________________ Maxim Integrated Products   1 

For pricing, delivery, and ordering information, please contact Maxim Direct at 1-888-629-4642, or 
visit Maxim’s website at www.maxim-ic.com. 

 

Downloaded from: http://www.datasheetcatalog.com/

http://www.datasheetcatalog.com/


_________________________________________________________________________________________________ DS33M33DK 

Rev: 102108 2 of 48 

Table of Contents 

1. BOARD FLOORPLAN .....................................................................................................................3 

2. PC BOARD ERRATA.......................................................................................................................3 

3. FILE LOCATIONS............................................................................................................................4 

4. BASIC OPERATION ........................................................................................................................5 

4.1 POWERING UP THE DEMO KIT..........................................................................................................5 

4.1.1 General .................................................................................................................................................. 5 

4.2 BASIC DS33M33 INITIALIZATION......................................................................................................5 

4.2.1 Additional configuration for DS33M33 ................................................................................................... 5 

4.3 MONITOR AND CAPTURE ETHERNET TRAFFIC ...................................................................................5 

5. JUMPERS AND CONNECTORS .....................................................................................................6 

6. LINE-SIDE CONNECTIONS ............................................................................................................9 

7. SYSTEM CONNECTORS ................................................................................................................9 

8. MICROCONTROLLER.....................................................................................................................9 

9. POWER-SUPPLY CONNECTORS ..................................................................................................9 

10. CONNECTING TO A COMPUTER ..................................................................................................9 

11. INSTALLING AND RUNNING THE SOFTWARE..........................................................................10 

12. ADDRESS MAP .............................................................................................................................11 

12.1 OVERHEAD CPLD REGISTER MAP..............................................................................................11 

12.2 CONTROL AND STATUS REGISTERS ............................................................................................12 

13. ADDITIONAL INFORMATION/RESOURCES................................................................................16 

13.1 DS33M33 INFORMATION............................................................................................................16 

13.2 DS33M33DK INFORMATION.......................................................................................................16 

13.3 TECHNICAL SUPPORT.................................................................................................................16 

14. COMPONENT LIST........................................................................................................................16 

15. SCHEMATICS ................................................................................................................................21 

List of Figures 

Figure 1-1. DS33M33DK Board Floorplan................................................................................................................... 3 

Figure 15-1. DS33M33 PCB Layout and Schematic Hierarchy Block Page Listing.................................................. 21 

 

List of Tables 

Table 3-1. Definition and Configuration Files .............................................................................................................. 4 

Table 5-1. Jumpers and Connectors ........................................................................................................................... 6 

Table 12-1. Address Map .......................................................................................................................................... 11 

Table 12-2. Register Map for Overhead CPLD (Reference Designator U01) ........................................................... 11 

 

Downloaded from: http://www.datasheetcatalog.com/

http://www.datasheetcatalog.com/


_________________________________________________________________________________________________ DS33M33DK 

Rev: 102108 3 of 48 

1. Board Floorplan 

Figure 1-1. DS33M33DK Board Floorplan 

 
 
 
 

2. PCB Errata 

There are no errata for the DS33M33DK02A0. 
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3. File Locations 

This demo kit relies upon several supporting files, which are provided on the CD and are available as a zip file from 
the Maxim website www.maxim-ic.com/DS33M33DK. All locations are given relative to the directory in the CD/zip 
file called “DS33M33_def_ini_”. Table 3-1 shows the DS33M33, DS3154, and FPGA register definition files and 
configuration files. 

Table 3-1. Definition and Configuration Files 

FILE NAME FILE USAGE 

. \parallel_mode\ _DS33M_GlobalSonet.def Top level definition file to select in 
ChipView’s register mode. This file 
will autoload the remaining 
definition files for the DS33M33 
when parallel mode is used. (Note 
the wan files still need to be loaded 
(either DS)). 

.\parallel_mode\DS3154DC.def 

.\parallel_mode\ds33M_BufferMan.def 

.\parallel_mode\ds33M_EncapDecap.def 

.\parallel_mode\ds33M_GlobalEth.def 

.\parallel_mode\ds33M_group.def 

.\parallel_mode\ds33M_LanSubscriber.def 

.\parallel_mode\DS33M_port1.def 

.\parallel_mode\DS33M_port2.def 

.\parallel_mode\DS33M_port3.def 

.\parallel_mode\DS33M_serial_1234.def 

.\parallel_mode\DS33M_TEST.def 

.\parallel_mode\ds33M_Vcat.def 

.\parallel_mode\Overhead_FPGA.def 

DS33M33 dependent files. These 
are called by 
_DS33M_GlobalSonet.def file, 
which is listed above. 

.\parallel_mode\m33_eos_vcg0_port2_port3_mii.mfg File for manually configuring the 
DS33M33 for EoS VC3 with two 
ports assigned to VCG1. 

.\parallel_mode\m33_eos_vc3_mii100.mfg     File for manually configuring the 
DS33M33 for EoS VC3 mode. 

.\parallel_mode\m33_eopos_ds3.mfg File for manually configuring the 
DS33M33 for EoPoS DS3 mode. 

.\parallel_mode\enc_dec_lb.mfg Encap/decap loopback/ 

.\parallel_mode\m30_rx_tx.mfg M30 mode Rx and Tx 
configuration. This file configures 
the MAC for GMII mode and 
requires a Gigabit Ethernet link.  

.\parallel_mode\norm_ds3154_dlb.mfg 

.\parallel_mode\m33_pos_au3_liu.mfg 
Two files for configuring the LIU in 
M33 mMode and configuring the 
DS33M33 in PoS AU3 mode. 

.\ spi_mode.zip Configuration mode files for SPI™ 
3-wire bus mode. The default 
mode for this demo kit is parallel 
mode. To avoid accidental use the 
SPI mode files have been provided 
in a zip format. 

.\ ParitalConfig_DS33M_100mBit.mfg 

.\ ParitalConfig_DS33M_GigaBit.mfg 
Files to change Ethernet speed in 
the MAC and Global Ethernet 
section. 

SPI is a trademark of Motorola, Inc. 
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4. Basic Operation 

Note: In the following sections, software-related items are identified by bolding. Text in bold refers to items directly 
from the EV kit software. Text in bold and underlined refers to items from the Windows operating system.  

4.1 Powering Up the Demo Kit 

• Connect PCB power jack to the wall adapter.  • Connect RS232 serial cable, or USB cable between the host PC and demo kit. • Verify that the jumpers are configured as described in Table 5-1. 

4.1.1 General 

• Upon power-up the power LEDs (DS30, DS31, DS32 green) will be lit. Note that with DS33M3301A0 board 
revision, the LED DS31 will be red when power conditions are correct. • PHY LINK LED should be lit if an Ethernet cable is connected.  

Following are several basic system initializations. 

4.2 Basic DS33M33 Initialization  

This section covers two basic methods for configuring the DS33M33.  
1. Device Driver-Based Configuration: (Note: The DS33M3302A0 board revision does not come loaded with 

device drivers). If the pins J20.1+J20.2 are Jumpered the device driver will auto configure the DS33M33 
upon power-up. This enables traffic to pass from the Ethernet port to the serial port. Consult the device 
driver documentation for further details. To load the GUI interface for the device drivers, go to the ChipView 
register mode Tools menu and select Tools→Plugins→DS33M30/M33 Device Driver Demo. 

2. Register-Based Configuration: EoS VC3 with two ports assigned to VCG1.  
a. Remove jumper J20.1+J20.2 to disable device drivers, and reset the board.  
b. Launch ChipView.exe and select Register View.  
c. When prompted for a definition file, pick the file named _DS33M33_GlobalMicroport.def. Several 

additional definition files will load.  
d. Go to the File menu and select File→Memory Config File→Load .MFG file. When prompted, 

select the file named m33_eos_vcg0_port2_port3_mii.mfg.  

4.2.1 Additional Configuration for DS33M33 

• Using either a patch or crossover cable, connect the Ethernet connector to an ordinary PC or network test 
equipment. This should cause the link LED to turn on. • Place a loopback connector at the SONET network side; the optical LOS LEDs should go out.  • At this point any packets sent to the DS33M33 are echoed back. Incoming packets (i.e., ping) should 
cause the Activity LED to blink. • Note that ChipView.exe display settings can be changed using the Options→Settings menu.  

4.3 Monitor and Capture Ethernet Traffic 

• Although ping is mentioned, it is not the recommended frame source for testing. The ping command goes 
through the computer’s TCPIP stack, and sometimes is not sent out the PC’s network connector (i.e., if the 
PC’s ARP cache is out of date). Additionally, ping requires two PCs, as a Windows PC with only one 
adapter cannot ping itself (i.e., a local ping gets sent to local host instead of out the connector). With that 
said, ping is still a valuable test once the prototyping stage is complete. • Generation and capture of arbitrary (raw) packets can be accomplished using CommView. A time-limited 
demo is available at www.tamos.com/products/commview. • Wireshark (formerly Ethereal) is a free packet capture utility. Download is available at www.wireshark.org. • Adding additional Ethernet ports to a PC is rather simple when a USB-to-Ethernet adapter is used. This 
allows for end-to-end testing using a single PC. When using two adapters, the PC has a different IP 
address for each adapter. Test equipment allows selection of either adapter. Operating system-based 
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network traffic is sent out the default adapter, which usually is the adapter that has recently had connection 
to a live network.  

5. Jumpers and Connectors 

Jumpers and connectors are listed in Table 5-1. They are listed in order of appearance on the PCB from left to 
right, top to bottom (as viewed with SONET connectors port on the left side of the board). 

Table 5-1. Jumpers and Connectors 

SILKSCREEN 
REFERENCE 

FUNCTION 
BASIC 

SETTING 
SCHEMATIC 

PAGE 
DESCRIPTION 

J05 Overhead Test Points 
J05.5+J05.6 
Jumpered 

2 

Jumpers to connect overhead 
CPLD to DS33M33. Connector is 
marked to show that the odd 
numbered pins belong to the 
CPLD. 

J02 Spare Connector Not used 23 
Spare pins connected to overhead 
CPLD. 

J08 Overhead Test Points — 2 

Jumpers to connect overhead 
CPLD to DS33M33. Connector is 
marked to show that the odd 
numbered pins belong to the 
CPLD. 

JB01 
(bottom of PCB) 

JTAG — 24 CPLD JTAG header. 

Jumper 
P2+1 (low) 
P2+1 (low) 

26 

If auto negotiation is enabled, this 
setting advertises capability for 
10/100/1000 speeds. If auto 
negotiation is disabled, then this 
setting forces 10Mb mode. 

Jumper 
P2+3 (high) 
P2+3 (high) 

26 

If auto negotiation is enabled this 
setting advertises capability for 
10/100 speeds. If auto negotiation 
is disabled, this setting is not legal. 

JP05 + JP02 
Bias PHY 

Speed1 + Speed0 

Jumper 
P2+3(high) 
P2+1 (low) 

26 

If auto negotiation is enabled, this 
setting advertises capability for 
1000 speeds. If auto negotiation is 
disabled, this setting forces 
1000Mb mode. 

Note: In Gigabit mode the DS33M33 Mac must be configured with indirect Mac register MACCR bit 15 set. 

JP03 Bias PHY ANEN 
Jumper 

P2+3 (high) 
26 

Jumper P2+3 to enable auto 
negotiation. 

JP04 Bias PHY Duplex 
Jumper 

P2+3 (high) 
26 

Jumper P2+3 to enable full duplex; 
jumper P1.2 to force half duplex. 

JP06 Bias PHY ManMDIX 
Jumper 

P2+1 (high) 
26 

Default MDIX setting P2+3 PHY is 
set to straight mode; P2+1 PHY is 
in crossover mode. 

JP07 Bias PHY NonIEEE 
Jumper 

P2+3 (high) 
26 

Jumper P2+3 to enable IEEE 
compliant operation. 

JP08 Bias PHY MultiEn 
Jumper 

P2+1 (high) 
26 

PHY advertisement setting. 
P2+3 selects multiple node priority 
(switch or hub); P1+2 selects single 
node priority (NIC). 

JP09 Bias PHY MdixEn 
Jumper 

P2+1 (high) 
26 

P2+3 disables pair swap mode, 
P2+1 enables pair swap mode 
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SILKSCREEN 
REFERENCE 

FUNCTION 
BASIC 

SETTING 
SCHEMATIC 

PAGE 
DESCRIPTION 

JP10 Bias PHY MacClkEn 
Jumper 

P2+3 (low) 
26 

P2+3 PHY clock to mac output is 
disabled, P1+2 PHY clock to mac 
output is enabled. Mac clock only 
needs to be enabled in Gigabit 
mode. 

DS14 LED activity — 26 Flashes for PHY Tx-Rx activity. 

DS15 
DS16 
DS17 

LED link speed 
1 of the 3 

should be lit 
(when linked) 

26 

LED to indicate link speed–1000, 
100, or 10Mbps. Only one of the 
three LEDs should be lit. See JP05 
+ JP02 description for setting in 
GMII vs. MII mode. 

DS18 LED duplex — 25 LED is on in full-duplex mode. 

JB03 
JB02 

PHY Test Points — 19 

PHY test points. The connector 
pinout is compatible with existing 
PHY cards, but cannot be used 
with U04 on the board. 

J16 JTAG 
Jumper 

J16.1+J16.3 
8 DS33M33 JTAG. 

J20 Runtime options NA 1 
Currently the device drivers do not 
fit in flash, and are not loaded to 
the DK. 

J31 JTAG — 31 FPGA JTAG. 

JP25 
JP26 

Comm Port 
Jumper 
P1+2 
P1+2 

15 

Jumper pins 1+2 to select the 
RS232 transceiver. Jumper pins 
2+3 to select the USB to serial 
converter. 

SW01 Reset — 11 System reset button. 

J21 Test Points — 8 Databus test points, pins D0–D15 

J24 Test Points — 8 
Address bus test points pins A0–
A13. 

J23 Test Points — 8 
Test points for DS33M33 CS, WR 
RD, and INT. 

JP22 
JP21 
JP20 

SPI Bias 
SWAP 
CPHA 
CPOL 

Jumper 
P1+2 

8 

Jumper pins 2+1 to connect to 
processor parallel databus. Leave 
jumper off to pull pin low, jumper 
pins 2+3 to pull pin high. 

JP14 
JP13 
JP12 
JP11 

SPI connection 
CS 

MISO 
MOSI 
SCK 

Jumper 
P1+2 

8 
Jumper Pins 2+1 to connect to 
parallel databus. Jumper pins 2+3 
to connect to SPI port. 

J30 

Pin Bias 
IFSEL_SIZE 

IFSEL_STYLE 
SPISEL 

HIZ 
DCESEL 
RMIISEL 

ALE 
 

Jumper 
IFSEL_STYLE 

HIZ_N 
(parallel mode) 

 

8 
Jumper to pull high, leave jumper 
off to pull low. 

J19 Clock select Jumper P2+4 6 
Clock selection for PHY and 
Ethernet side of DS33M33. 

JP01 Clock select Jumper P1+2 6 
Clad clock selection, jumper P1+2 
to drive with 19.44MHz. Jumper 
P2+3 to drive with 77.76MHz clock. 

Downloaded from: http://www.datasheetcatalog.com/

http://www.datasheetcatalog.com/


_________________________________________________________________________________________________ DS33M33DK 

Rev: 102108 8 of 48 

SILKSCREEN 
REFERENCE 

FUNCTION 
BASIC 

SETTING 
SCHEMATIC 

PAGE 
DESCRIPTION 

J09 
J10 

SerDes analog test 
points 

— 3, 4 

Test points to view analog +- 
differential SerDes signals. To 
loopback DS33M33 Tx→Rx 
remove the SFP and jumper P3+5 
and P2+6. 

J03 
J04 

SFP test points Jumper P9+10 3 Test points for SFP module. 

DS02 
DS03 

SFP MOD0 — 3 Lit when a SFP module is installed. 

DS08 
DS09 

SFP TXDISABLE — 3 Lit when Tx is enabled. 

DS05 
DS04 

SFP LOS — 3 
Lit when fiber optic cable is 
removed. 

J06 
J07 

SFP LOS / M33 LOS Jumper P2+3 3, 4 

Jumper P2+3 to connect SFP LOS 
to DS33M33 LOS. Jumper P2+4 to 
pull DS33M33 high. Jumper P2+6 
to pull DS33M33 low. 

U03 SFP Installed 3, 4 Primary SFP module. 

U02 SFP Not Installed 3, 4 Redundant SFP module. 

J33 Software Debug — 15 ONcE EBDI. 

J32 JTAG — 20 LIU JTAG. 

J13 
J15 
J18 

RCLK 
RNEG 
RPOS 

Jumpered 9 LIU-to-DS33M33 connections. 

J13 
J15 
J18 

TCLK 
TNEG 
TPOS 

Jumpered 9 LIU-to-DS33M33 connections. 

JP16 
JP23 
JP24 

LIU Port Clocks Not used 9 
Jumper 1+2 to drive TCLKn with 
OscSel. Jumper 2+3 to drive 
TCLKn with RCLKn. 

J22 
J25 
J26 
J27 

JB05 
JB06 
J28 
J29 

RX3 
TX3 
RX1 
TX1 

RX4 (bottom of PCB) 
TX4 (bottom of PCB) 

RX2 
TX2 

— 8 Rx Tx jumpers. 

JP17 LIU_T3MCLK 
Jumper 
P2+3 

20 
Jumper P2+3 to drive with T3 Osc. 
Jumper P1+2 to drive with 
T3_MCLK_IO. 

JP18 LIU_ALT_MCLK 
Jumper 
P2+3 

20 
Jumper P2+3 to drive with Osc Sel. 
Jumper P1+2 to drive with 
Alternate MCLK. 

JP19 LIU_E3MCLK 
Jumper 
P2+3 

20 
Jumper P2+3 to drive with E3 Osc. 
Jumper P1+2 to drive with 
E3_MCLK_IO. 

JP15 Osc Select 
Jumper 
P2+3 

20 
Jumper P2+3 to drive with T3 Osc. 
Jumper P1+2 to drive with E3 Osc. 
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6. Line-Side Connect ions 

The DS33M33DK has two optical ports: one Ethernet port and three T3E3 ports. 

7. System Connectors 

System-side signals can be accessed from test point headers. The headers are clearly labeled with signal 
information.  

8. Microcontroller 

The microcontroller has factory-installed firmware in on-chip nonvolatile memory. This firmware translates memory 
access requests from the RS-232 serial port into register accesses on the DS33M33 and the FPGAs.  

9. Pow er-Supply Connectors 

Connect a 5.0V wall adapter to the PCB power jack. LED DS1 provides indications that a 5.0V supply is connected 
properly. The board power supplies (3.3V, 2.5V, and 1.8V) are regulated to supply proper voltages to various 
circuits on the board. 

10. Connect ing to a Computer 

Both USB and serial modes are supported. 

To connect through a RS-232 serial port, set jumpers JP25 and JP26 jumpers to pins 1+2, identified in the 
silkscreen as UART,PROC. Connect a standard DB-9 serial cable between the serial port on the DS33M33DK and 
an available serial port on the host computer. The host computer must be a Windows-based PC. Be sure the cable 
is a standard straight-through cable rather than a null-modem cable. Null-modem cables prevent proper operation. 

To connect through USB, set jumpers JP25 and JP26 jumpers to pins 3+2, identified in the silkscreen as 
USB,PROC. Connect a USB cable between the DS33M33DK USB connector and the PC. The host computer must 
be a Windows-based PC, which should automatically recognize the device as a virtual com port and assign the 
device drivers. If drivers are not automatically assigned, direct the New Hardware wizard to the driver files on the 
CD in the folder marked USBdrivers_CP210x. 

Downloaded from: http://www.datasheetcatalog.com/

http://www.datasheetcatalog.com/


_________________________________________________________________________________________________ DS33M33DK 

Rev: 102108 10 of 48 

11. Installing and Running the Software 

ChipView is a general-purpose program that supports a number of Maxim demo kits. To install the ChipView 
software, run Chipview.msi from the disk included in the DS33M33DK box or from the zip file downloadable on our 
website at www.maxim-ic.com/DS33M33DK. 

After installation, run the ChipView program with the DS33M33DK board powered up and connected to the PC. If 
the default installation options were used, one easy way to run ChipView is to click the Start button on the 

Windows toolbar and select Programs→ChipView→ChipView. In the opening screen, click the Register View 
button. Select the correct serial port in the Port Selection dialog box, then click OK. 

Next, the Definition File Assignment window appears. This window has subwindows to select definition files for 
up to four separate boards on other Maxim evaluation platforms. In the active subwindow, select the 
_DS33M_GlobalSonet.def definition file from the list shown, or browse to find it in another directory. Press the 
Continue button. 

After selecting the definition file, the main part of the ChipView window displays the DS33M33’s register map. To 
select a register, click on it in the register map. When a register is selected, the full name of the register and its bit 
map are displayed at the bottom of the ChipView window. Bits that are logic 0 are displayed in white, while bits that 
are logic 1 are displayed in green. 

The ChipView software supports the following actions: 

• Toggle a bit. Select the register in the register map and then click the bit in the bit map.  • Write a register. Select the register, click the Write button, and enter the value to be written.  • Write all registers. Click the Write All button and enter the value to be written.  • Read a register. Select the register in the register map and click the Read button. • Read all registers. Click the Read All button. 
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12. Address Map 

Address space begins at 0x81000000. All offsets given in the following tables are relative to 0x81000000. 
Registers in the FPGA can be easily modified using the ChipView host-based user interface software along with 
the definition file named Overhead_FPGA.def. 

Table 12-1. Address Map 

OFFSET DEVICE DESCRIPTION 

0X6000 FPGA Overhead CPLD and Clock/Signal Routing 

0X4000 DS3154 DS3154 Line Interface Unit 

0X0000 DS33M33 DS33M33 Registers 

12.1 Overhead CPLD Register Map 

Table 12-2. Register Map for Overhead CPLD (Reference Designator U01) 

OFFSET 
REGISTER 

NAME 
TYPE DESCRIPTION 

0X0001 ATOH_CFG Control ATOH Configuration 

0X0002 ATOHEN_CFG Control ATOHEN Configuration 

0X0003 GPIOAwr Control GPIO A Output Enable + Write Value 

0X0004 GPIOBwr Control GPIO B Output Enable + Write Value 

0X0005 DTOH_STAT Read-Only DTOH Status 

0X0006 DTOH_SEL Control DTOH Configuration 

0X0007 GPIOrd_STAT Read-Only GPIO Read Values 

0X0008 RDOH_STAT Read-Oonly RDOH Status 

0x000A RDOH_SEL Control RDOH Select 

0x000D TAOH_CFG Control TAOH Configuration 

0x000F TAOHen_CFG Control TAOHen Configuration 
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12.2 Control and Status Registers 

 
Register Name: ATOH_CFG 
Register Description: ATOH Configuration 
Register Offset: 0x0001 
 
Bit # 7 6 5 4 3 2 1 0 

Name         

Default 0 0 0 0 0 0 0 0 

This register sets the overhead transport data byte value, which is positioned by the following register, 
ATOHEN_CFG. 

 
 
Register Name: ATOHEN_CFG 
Register Description: ATOHEN Configuration 
Register Offset: 0x0002 
 
Bit # 7 6 5 4 3 2 1 0 

Name         

Default 0 0 0 0 0 0 0 0 

 
Byte enable for overhead transport byte, the data value in ATOH_CFG is positioned in the overhead as specified 
by ATOHEN_CFG. Examples follow: 
 

ATOHEN_CFG ATOH_CFG RESULT 

0 NA Data is not written onto the overhead when ATOHEN_CFG = 0. 

0x01 0x54 Data value 0x54 is written onto the first byte of the transport overhead. 

0x81 0x54 Data value 0x54 is written onto the last byte of the transport overhead. 

0x## 0xNN Data value 0xNN is written to the 0x## byte of the transport overhead. 
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Register Name: GPIOAwr 
Register Description: GPIO A Output Enable + Write Value  
Register Offset: 0x0003 
 
Bit # 7 6 5 4 3 2 1 0 

Name 
— — 

GPIOa3 
Output En 

GPIOa3 
Value 

GPIOa2 
Output En 

GPIOa2 
Value 

GPIOa1 
Output En 

GPIOa1 
Value 

Default 0 0 0 0 0 0 0 0 

 
 
Bits 5 and 4: DS33M33 GPIOA_3 Three-State and Level  

0x = FPGA three-states GPIOA_3 pin 
00 = FPGA drives GPIOA_3 pin with 0.0V 
01 = FPGA drives GPIOA_3 pin with 3.3V 

 
Bits 3 and 2: DS33M33 GPIOA_2 Three-State and Level  

0x = FPGA three-states GPIOA_2 pin 
00 = FPGA drives GPIOA_2 pin with 0.0V 
01 = FPGA drives GPIOA_2 pin with 3.3V 

 
Bits 1 and 0: DS33M33 GPIOA_1 Three-State and Level  

0x = FPGA three-states GPIOA_1 pin 
00 = FPGA drives GPIOA_1 pin with 0.0V 
01 = FPGA drives GPIOA_1 pin with 3.3V 
 

 
 
Register Name: GPIOBwr 
Register Description: GPIO B Output Enable + Write Value  
Register Offset: 0x0004 
 
Bit # 7 6 5 4 3 2 1 0 

Name 
— — 

GPIOb3 
Output En 

GPIOb3 
Value 

GPIOb2 
Output En 

GPIOb2 
Value 

GPIOb1 
Output En 

GPIOb1 
Value 

Default 0 0 0 0 0 0 0 0 

 
Bits 5 and 4: DS33M33 GPIOB_3 Three-State and Level control 

0x = FPGA three-states GPIOB_3 pin 
00 = FPGA drives GPIOB_3 pin with 0.0V 
01 = FPGA drives GPIOB_3 pin with 3.3V 

 
Bits 3 and 2: DS33M33 GPIOB_2 Three-State and Level control 

0x = FPGA three-states GPIOB_2 pin 
00 = FPGA drives GPIOB_2 pin with 0.0V 
01 = FPGA drives GPIOB_2 pin with 3.3V 

 
Bits 1 and 0: DS33M33 GPIOB_1 Three-State and Level control 

0x = FPGA three-states GPIOB_1 pin 
00 = FPGA drives GPIOB_1 pin with 0.0V 
01 = FPGA drives GPIOB_1 pin with 3.3V 
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Register Name: DTOH_STAT 
Register Description: DTOH Status  
Register Offset: 0x0005 
 
Bit # 7 6 5 4 3 2 1 0 

Name STAT7 STAT6 STAT5 STAT4 STAT3 STAT2 STAT1 STAT0 

Default 0 0 0 0 0 0 0 0 

Read value of 1 of 81 bytes selected by DTOH_SEL. 
 
 
Register Name: DTOH_SEL 
Register Description: DTOH Configuration  
Register Offset: 0x0006 
 
Bit # 7 6 5 4 3 2 1 0 

Name SEL7 SEL6 SEL5 SEL4 SEL3 SEL2 SEL1 SEL0 

Default 0 0 0 0 0 0 0 0 

Byte select for overhead transport byte, the overhead byte specified by DTOH_CFG is written to DTOH_STAT. 
 
Examples: 

DTOH_SEL DTOH_STAT RESULT 

0 First byte The first byte of the transport overhead is written to DTOH_STAT. 

0x80 Last byte The last byte of the transport overhead is written to DTOH_STAT. 

 
 
Register Name: GPIOrd_STAT 
Register Description: GPIO Read Values  
Register Offset: 0x0007 
 
Bit # 7 6 5 4 3 2 1 0 

Name — GPIOA3 GPIOA2 GPIOA1 — GPIOB3 GPIOB2 GPIOB1 

Default 0 0 0 0 0 0 0 0 

Bit 6: DS33M33 GPIOA3 Pin Value  
 Reflects the value of DS33M33 GPIOA3 pin. 
 

Bit 5: DS33M33 GPIOA3 Pin Value  
 Reflects the value of DS33M33 GPIOA2 pin. 
 

Bit 4: DS33M33 GPIOA3 Pin Value  
 Reflects the value of DS33M33 GPIOA1 pin. 
 
Bit 2: DS33M33 GPIOA3 Pin Value  
 Reflects the value of DS33M33 GPIOB3 pin. 
 

Bit 1: DS33M33 GPIOA3 Pin Value  
 Reflects the value of DS33M33 GPIOB2 pin. 
 

Bit 0: DS33M33 GPIOA3 Pin Value  
 Reflects the value of DS33M33 GPIOB1 pin. 
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Register Name: RDOH_STAT 
Register Description: RDOH Status 
Register Offset: 0x0008 
 
Bit # 7 6 5 4 3 2 1 0 

Name — — — — — — — — 

Default 0 0 0 0 0 0 0 0 

Read value from the member and byte selected by RDOH_SEL[7:4] and RDOH_SEL[3:0] 

 
 
Register Name: RDOH_SEL 
Register Description: RDOH Select 
Register Offset: 0x000A 
 
Bit # 7 6 5 4 3 2 1 0 

Name IF3 IF2 IF1 IF0 B3 B2 B1 B0 

Default 0 0 0 0 0 0 0 0 

Bits 7 to 4: Overhead interface Member Select.  Writing IF[3:0] to a value of 0 disables. Writing 1 to 10 selects 
among the 10 members used in RDOH_STAT. 

Bits 3 to 0: Byte Select. Writing B[3:0] to a value of 0-to-N selects the Nth byte in the member selected. 

 
 
Register Name: TAOH_CFG 
Register Description: TAOH Configuration 
Register Offset: 0x000D 
 
Bit # 7 6 5 4 3 2 1 0 

Name RCLK8 RCLK7 RCLK6 RCLK5 RCLK4 RCLK3 RCLK2 RCLK1 

Default 0 0 0 0 0 0 0 0 

Value to be written to the member and byte selected by TAOHen_CFG[7:4] and TAOHen_CFG [3:0] 

 
 
Register Name: TAOHen_CFG 
Register Description: TAOH Enable Configuration 
Register Offset: 0x000F 
 
Bit # 7 6 5 4 3 2 1 0 

Name IF3 IF2 IF1 IF0 B3 B2 B1 B0 

Default 0 0 0 0 0 0 0 0 

Bits 7 to 4: Overhead interface Member Select.  Writing IF[3:0] to a value of 0 disables. Writing 1 to 10 selects 
among the 10 members used in TAOH_STAT. 

Bits 3 to 0: Byte Select. Writing B[3:0] to a value of 0-to-N selects the Nth byte in the member selected. 
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13. Additional Information/Resources 

13.1 DS33M33 Information 

For more information about the DS33M33, refer to the DS33M33 data sheet at www.maxim-ic.com/DS33M33.  

13.2 DS33M33DK Information 

For more information about the DS33M33DK, refer to the DS33M33DK Quick View page at 
www.maxim-ic.com/DS33M33DK. 

13.3 Technical Support 

For additional technical support, submit your questions at www.maxim-ic.com/support. 
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14. Component List 

DESIGNATION QTY DESCRIPTION SUPPLIER PART 

C08, CB34, CB36, CB37, CB38, 
CB39, CB40, CB41, CB42, CB58, 
CB64, CB66, CB67, CB68, CB72, 

CB79, CB92, CB101, CB104, 
CB112, CB170 

21 L_0603 CERAM .01uF 50V 10% X7R AVX 06035C103KAT 

See next row (begins with C02) 61 L_0603 CERAM .1uF 16V 20% X7R AVX 0603YC104MAT 

C02, C04, C05, C07, C10, C15, C18, CB05, CB06, CB09, CB10, CB11, CB12, CB16, CB21, CB22, CB23, CB25, CB28, 
CB33, CB43, CB44, CB45, CB47, CB53, CB54, CB63, CB65, CB69, CB77, CB83, CB85, CB88, CB89, CB94, CB95, CB97, 

CB98, CB113, CB115, CB116, CB118, CB122, CB126, CB128, CB134, CB135, CB137, CB138, CB140, CB142, CB143, 
CB144, CB146, CB148, CB156, CB160, CB168, CB177, CB186, CB187 

DB01 1 SCHOTTKY DIODE, 1 AMP 40 VOLT 
International 
Rectifier 

10BQ040 

DS01, DS06, DS07, DS10, DS11, 
DS12, DS13, DS31 

8 LED, RED/GREEN, SMD LITEON 160-1172-1-ND 

GND_TP01, GND_TP02, 
GND_TP03, GND_TP04, 

GND_TP11, GND_TPB01, 
GND_TPB02, GND_TPB03, 

GND_TPB06 

9 STANDARD GROUND CLIP KEYSTONE 4954 

DS14, DS15, DS16, DS17 4 LED, GREEN/GREEN, SMD LUMEX 67-1362-1-ND 

J34 1 L_CONN, DB9 RA, LONG CASE AMP 747459-1 

UB02, UB04, UB06 3 
SPI SERIAL EEPROM 2M 8 PIN SOIC 
2.7V to 3.6V 

Atmel 
AT25F2048N-
10SU-2.7 

RPB24, RPB26 2 
RESISTOR, 4 PACK, 50 OHM 2PCT 
QUAD 0603 

KOA CN1J4TTD500G 

U10 1 
IC, SINGLE-CHIP USB TO UART 
BRIDGE, 28 PIN QFN 

SIL CP2101 

J32 1 
L_TERMINAL STRIP, 10 PIN, DUAL 
ROW, VERT DO NOT POPULATE 

DNP DNP 

U04 1 
GIG PHYTER V, 10/100/1000 
ETHERNET PHYSICAL LAYER, 128 
PIN QFP 

National 
Semiconductor 

DP83865DVH 

U07 1 QUAD DS3/E3/STS1 LIU 144P BGA Maxim DS3154 

U05 1 
IC, ETHERNET OVER SDH/SONET 
(EoS), -40C TO 85C, 256-PIN CSBGA 

Maxim DS33M33N 

XB01 1 XTAL LOW PROFILE 8.0MHZ ECL EC1-8.000M 

See next row (begins with C01) 79 
0603 CERAM 4.7uF 6.3V 
MULTILAYER 

Digi-Key ECJ-1VB0J475M 

C01, C03, C06, C09, C11, C12, C13, C14, C16, C23, CB03, CB04, CB07, CB14, CB15, CB17, CB18, CB19, CB20, CB24, 
CB26, CB27, CB29, CB30, CB31, CB32, CB46, CB49, CB55, CB60, CB62, CB70, CB73, CB74, CB75, CB76, CB78, CB82, 
CB84, CB86, CB90, CB91, CB93, CB96, CB100, CB102, CB103, CB106, CB107, CB109, CB110, CB114, CB117, CB119, 
CB120, CB121, CB123, CB127, CB129, CB131, CB132, CB133, CB136, CB139, CB141, CB147, CB150, CB153, CB154, 

CB162, CB163, CB165, CB167, CB173, CB175, CB181, CB182, CB183, CB190 

See next row (begins with CB50) 20 0603 CERAM .1uF 16V 10% Panasonic ECJ-1VB1C104K 
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CB50, CB56, CB57, CB61, CB71, CB80, CB81, CB87, CB99, CB105, CB108, CB149, CB151, CB152, CB155, CB161, 
CB166, CB172, CB179, CB180 

See next row (begins with C17) 21 1206 CERAM 10uF 10V 20% Panasonic ECJ-3YB1A106M 

C17, C19, C20, C21, C22, C24, CB188 , CB01, CB02, CB08, CB13, CB35, CB48, CB51, CB52, CB59, CB111, CB124, 
CB125, CB130, CB169 

CB164, CB184 2 L_1206 CERAM 1uF 16V 10% Panasonic ECJ-3YB1C105K 

CB178 1 1206 CERAM 4.7uF 25V 10% X5R Panasonic ECJ-3YB1E475K 

CB158, CB159, CB185, CB189 4 L_D CASE TANT 68uF 16V 20% Panasonic ECS-T1CD686R 

RB09, RB10 2 RES 0603 100 Ohm 1/16W 1% Panasonic ERJ-3EKF1000V 

RB12, RB13 2 RES 0603 1.00K Ohm 1/16W 1% Panasonic ERJ-3EKF1001V 

RB17, RB19, RB20, RB21, RB22, 
RB23, RB24, RB25 

8 RES 0603 332 Ohm 1/16W 1% Panasonic ERJ-3EKF3320V 

RB16 1 RES 0603 9.76K Ohm 1/16W 1% Panasonic ERJ-3EKF9761V 

R02, R04, R05, RB04, RB27 5 RES 0603 0.0 Ohm 1/16W 5% Panasonic ERJ-3GEY0R00V 

RB01, RB02, RB29 , RB05 4 L_RES 0603 10K Ohm 1/16W 5% Panasonic ERJ-3GEYJ103V 

R03 1 RES 0603 1.0M Ohm 1/16W 5% Panasonic ERJ-3GEYJ105V 

R01, RB06, RB11 3 RES 0603 2.0K Ohm 1/16W 5% Panasonic ERJ-3GEYJ202V 

RB08 1 RES 0603 2.2K Ohm 1/16W 5% Panasonic ERJ-3GEYJ222V 

RB14, RB15 2 RES 0603 30 Ohm 1/16W 5% Panasonic ERJ-3GEYJ300V 

RB07, RB26 , RB28, RB30 4 RES 0603 330 Ohm 1/16W 5% Panasonic ERJ-3GEYJ331V 

RB03, RB18 2 RES 0805 10K Ohm 1/10W 1% Panasonic ERJ-6ENF1002V 

SW01 1 SWITCH MOM 4PIN SINGLE POLE Panasonic EVQPAE04M 

RPB18 1 
RESISTOR, 4 PACK, 100 OHM 5PCT 
QUAD 0603 

Panasonic EXB-V8V101JX 

RPB01, RPB02, RPB05, RPB14, 
RPB20, RPB30, RPB36, RPB48, 

RPB52 
9 

RESISTOR, 4 PACK, 1K OHM 5PCT 
QUAD 0603 

Panasonic EXB-V8V102JX 

RPB03, RPB08, RPB10, RPB11, 
RPB12, RPB13, RPB29, RPB32, 
RPB33, RPB40, RPB41, RPB43, 
RPB45, RPB47, RPB49, RPB50, 
RPB51, RPB54, RPB55, RPB56, 
RPB57, RPB58, RPB60, RPB61, 

RPB62, RPB63, RPB64 

27 
RESISTOR, 4 PACK, 10K OHM 5PCT 
QUAD 0603 

Panasonic EXB-V8V103JX 

RPB19, RPB21, RPB28 3 
RESISTOR, 4 PACK, 2.2K OHM 5PCT 
QUAD 0603 

Panasonic EXB-V8V222JX 

RP02, RP03, RP04, RP05, RP06, 
RP07, RP08, RP09, RP10, RP11, 

RP12, RP13, RPB15, RPB16, 
RPB17, RPB23, RPB25, RPB27, 
RPB31, RPB34, RPB35, RPB37, 

RPB44 

23 
RESISTOR, 4 PACK, 30 OHM 5PCT 
QUAD 0603 

Panasonic EXB-V8V300JX 

RP01, RPB04, RPB06, RPB07, 
RPB09, RPB22, RPB38, RPB39, 
RPB42, RPB46, RPB53, RPB59 

12 
RESISTOR, 4 PACK, 330 OHM 5PCT 
QUAD 0603 

Panasonic EXB-V8V331JX 

L01, L02, LB01, LB02, LB03, 
LB04 

6 
1uH ±10% 0805 Multilayer Ceramic 
400 mA 

TDK GLF2012T1R0M 
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J01, J30 2 HEADER, 14 PIN, DUAL ROW, VERT Samtec 
HDR-TSW-107-14-
T-D 

J11 1 
CONNECTOR, SINGLE LEVEL, 
GIGABIT RJ-45, 10 PIN 

Halo 
Electronics 

HFJ11-1G02E 

U08 1 
IC, FPGA, 1.2V, 20X20 TQFP, 144 
PIN 

LAT LFE2-6E-5TN144C 

U01 1 
IC, FPGA, 1.2V, 20X20 TQFP, 144 
PIN 

LAT LFEC3E-3T144C 

DS04, DS05, DS28 , DS19, DS20, 
DS21, DS22, DS23, DS24, DS25, 

DS26, DS27 
12 L_LED, RED, SMD Panasonic LN1251C 

DS02, DS03, DS08, DS09, DS29 , 
DS18, DS30, DS32 

8 L_LED, GREEN, SMD Panasonic LN1351C 

UB09 1 
IC, LINEAR REG 1.5W, 1.8V or Adj, 
1A, 16TSSOP-EP 

Maxim MAX1793EUE-18 

UB08 1 
IC, LINEAR REG 1.5W, 2.5V or Adj, 
1A, 16TSSOP-EP 

Maxim MAX1793EUE-25 

UB10, UB11, UB13 3 
IC, LINEAR REG 1.5W, 3.3V or Adj, 
1A, 16TSSOP-EP 

Maxim MAX1793EUE-33 

UB01, UB03 2 
IC, LDO REGULATOR WITH 
RESET,1.20V OUTPUT 300 MA, 6 
PIN SOT23 

Maxim MAX1963EZT120-T 

UB07 1 
MICROPROCESSOR VOLTAGE 
MONITOR, 3.08V RESET, 4PIN 
SOT143 

Maxim MAX811TEUS-T 

U09 1 MMC2107 PROCESSOR Motorola MMC2107 

J03, J04, J23 3 
TERMINAL STRIP, 10 PIN, DUAL 
ROW, VERT 

Digi-Key S2012-05-ND 

J33 1 100 MIL 2*7 POS JUMPER NA NA 

J35 1 TYPE B SINGLE RT ANGLE, BLACK Digi-Key WM17108-ND 

JB08 1 100 MIL 2 POS JUMPER NA NA 

See next row (begins with JP01) 27 100 MIL 3 POS JUMPER NA NA 

JP01, JP02, JP03, JP04, JP05, JP06, JP07, JP08, JP09, JP10, JP11, JP12, JP13, JP14, JP15, JP16, JP17, JP18, JP19, 
JP20, JP21, JP22, JP23, JP24, JP25, JP26, JPB01 

TPB01, TPB02, TPB03 3 
TEST POINT, 1 PLATED HOLE, DO 
NOT STUFF 

NA NA 

U06 1 
DOUBLE DATA RATE (DDR) SDRAM 
2-2-2 TIMING 256MBITX16 TSSOP 

MICRON 
MT46V16M16TG-
75E 

U11, U12 2 CYPRESS SRAM 4Mbit*8 CYPRESS 
CY62148DV30L-
70SXI 

UB14 1 
Dual RS-232 transceivers with 3.3V/5V 
internal capacitors 

MAXIM MAX3233E 

JB02 1 
TEST POINTS FOR SMD 50 PIN, 2 
ROW VERTICAL 

NA 
NA_NOTPOPULAT
ED 

UB05 , UB12 2 HIGH SPEED INVERTER FAIRCHILD NC7SZ86 

J24 1 
NON POPULATED HEADER, 14 PIN, 
DUAL ROW, VERT 

Samtec 
NOPOP-HDR-TSW-
107-14-T-D 

JB05, JB06 2 
DO NOT POPULATE L_2 PIN 
HEADER, .100 CENTERS, VERTICAL 

Samtec 
NOPOP-TSW-102-
07-T-S 

J09, J10 2 
TERMINAL STRIP, 6 PIN, DUAL 
ROW, VERT NOT POPULATED 

Samtec 
NOPOP-TSW-103-
07-T-D 

J21 1 
NOPOP TERMINAL STRIP, 16 PIN, 
DUAL ROW, VERT 

Samtec 
NOPOP-TSW-108-
07-T-D 

YB04 1 
OSCILLATOR, CRYSTAL CLOCK, 
5.0V - 34.368 MHZ 

SaRonix NTH089AA-34.368 

YB05 1 
SOCKETED OSCILLATOR, CRYSTAL 
CLOCK, 3.3V - 25.000 MHZ 

SaRonix 
NTH089AA3-
25.000+SOCKET 

YB03 1 
OSCILLATOR, CRYSTAL CLOCK, 
3.3V - 44.736 MHZ 

SaRonix NTH089AA3-44.736 
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JB09 1 

CONN 2.1MM/5.5MM PWRJACK RT 
ANGLE PCB, closed frame, high 
current 24VDC@5A also requires 5V 
ACDC adapter INPUT 100-240VAC 
50-60HZ 0.6A OUTPUT DC 5V 2.6A. 
PN DMS050260-P5P-SZ. MODEL 3Z-
161WP05 

CUI, INC PJ-002AH 

JB03 1 
PLUG, SMD, 50 PIN, 2 ROW 
VERTICAL 

Samtec SFM-125-L2-S-D-LC 

U02, U03 2 SFP host / receptacle PARTS_KIT SFP_HOST-TYCO 

HB01, HB02, HB03, HB04, HB05 5 Rubber bumper 0.5 inch NA SJ5518-0 

YB01 1 
OSCILLATOR, CRYSTAL CLOCK, 
3.3V - 19.44 MHZ 

SaRonix 
SOCKET+NTH089A
3-19.44 

YB02 1 
OSCILLATOR, CRYSTAL CLOCK, 
3.3V - 77.76 MHZ 

SaRonix 
SOCKET+NTH089A
3-77.7600 

T01 1 
XFMR, OCTAL T3/E3, 1 TO 2, SMT 
32 PIN 

Pulse T3049 

CB145, CB157, CB171, CB174, 
CB176 

5 D CASE TANT 470uF 6.3V 20% KEM T491D477M006AS 

J22, J25, J26, J27, J28, J29 6 
L_2 PIN HEADER, .100 CENTERS, 
VERTICAL 

Samtec TSW-102-07-T-S 

J06, J07, J12, J13, J14, J15, J17, 
J18, J19, J20, JB04, JB07 

12 
TERMINAL STRIP, 6 PIN, DUAL 
ROW, VERT 

Samtec TSW-103-07-T-D 

J16, J31, JB01 3 
L_TERMINAL STRIP, 10 PIN, DUAL 
ROW, VERT 

Samtec TSW-105-07-T-D 

J02, J05, J08 3 
TERMINAL STRIP, 16 PIN, DUAL 
ROW, VERT 

Samtec TSW-108-07-T-D 
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Maxim cannot assume responsibility for use of any circuitry other than circuitry entirely embodied in a Maxim product. No circuit patent licenses 
are implied. Maxim reserves the right to change the circuitry and specifications without notice at any time. 

Maxim Integrated Products ,  120 San Gabrie l  Dr ive ,  Sunnyvale ,  CA 94086 408-737-7600                      

© 2008 Maxim Integrated Products                                                               

15. Schematics 

The DS33M33DK schematics are featured in the following pages. The schematic contains five hierarchal blocks: 
Microcontroller, DS3154, Ethernet PHY, Ethernet Test Points, and Overhead CPLD.  

All signals inside a hierarchy block are local, with exception for VCC and ground. In-port and out-port connectors are 
used to allow signals inside a hierarchy block to become accessible as pins on the hierarchy blocks symbol. From 
here blocks are wired together as if they were ordinary components. Figure 15-1 shows the system diagram in 
terms of hierarchal blocks with schematic page numbers given for each functional block. 

Figure 15-1. DS33M33 PCB Layout and Schematic Hierarchy Block Page Listing 
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SCHEMATIC 
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POWER SUPPLY 

 
SCHEMATIC 
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ETHERNET PHY 
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SCHEMATIC 
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CLOCKS AND CONFIGURATION 
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  is a registered trademark of Maxim Integrated Products. 
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MOD0 IS GROUNDED IN THE SFPPULLUPS FOR OPEN DRAIN PINS

THIS SUBCIRCUIT IS FOR OBSERVATION AND LOOPBACK ONLY
NOT FOR PRODUCTION USE

PLACE / ROUTE CAPS AND TESTPOINT

SUCH THAT THEY CAN REMOVED WITHOUT IMPACT

SERVES AS DEVICE DETECT
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PULLUPS FOR OPEN DRAIN PINS

THIS SUBCIRCUIT IS FOR OBSERVATION AND LOOPBACK ONLY
NOT FOR PRODUCTION USE

PLACE / ROUTE CAPS AND TESTPOINT

SUCH THAT THEY CAN REMOVED WITHOUT IMPACT

MOD0 IS GROUNDED IN THE SFP
SERVES AS DEVICE DETECT
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SERDES. P.3-4
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USED IN RMII MODE (50 MHZ)
ETH_REF_CLK IS ONLY

CLKA AND CLKB TESTPOINTS ARE IN THE LIU BLOCK
REFCLK & CLKC TESTPOINTS ARE IN THE PHY BLOCK
CLOCK TESTPOINTS:

NOT CONNECTION TO A RESOURCE CARD
IS INTENDED FOR USE AS TESTPOINTS
ETHERNET CONNECTOR (I.M. BUS)
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ETH_TXD<7..0>

CLK_TO_MAC

GTXCLK

ETH_COL_DET

ETH_RXD<7..0>

GMII_TX_ER_

I23

I24
1UH

4
.7

U
F

.1
U

F

M3X_CLADCLK_TO_LIU30

I22

2.
2K

30

30

25.000MHZ_3.3V_SOCKET

CLK_TO_MAC

AV_LAN_CLK

PY25MHZOSC

M3X_LAN_CLKO

M3X_CLKC

REFC_25M

JMP_3
M3X_CLADCLK

GMII_TX_ER_

19.44MHZ_3.3V_SOCKET

4
.7

U
F

.1
U

F

77.76MHZ_3.3V_SOCKET

CLK_TO_MAC

GTXCLK

AV_LAN_CLK

ETH_RXD<7..4>

ETH_TXD<7..4>

RESET_LAN

ETH_RXD<3..0>

ETH_RX_CLK

ETH_RXDV

ETH_RX_CRS

ETH_RX_ERR

ETH_TXD<3..0>

ETH_TX_CLK

ETH_TX_EN

ETH_MDIO
ETH_MDC

PY25MHZOSC

PHY_INT

M3X_LAN_CLK

30

R
B

08

YB02

4 5

1 8

JP01

1
3

2

RB15

RB14

YB01

4 5

1 8

YB05

4 5

1 8

J19

1 2

3 4

5 6

RP13

4

3

2

1

5

6

7

8

RPB23

4

3

2

1

5

6

7

8

L01

C
01

C
02

C
03

C
04

6/26(TOTAL)STEVE SCULLY
6/12(BLOCK)

10/03/2007

CR-6 : @\_RC_LIB\.\_RC_TOP_DN_\(SCH_1):PAGE6

DS33M33DK01A0

ETHERNET. P.5-6,19,25-26

BLOCK NAME: _rc_top_dn_.

6B1

25A7v19B3v

25B1v19B3v6A7

25B7v19B3v6A15A4

19C3v 5A525A1v

6B15C6

9B2

25B1v 19B3v 6B1 6C3

5A4

19B3v6B4

1A8

25B4v6B4

5A4

10B7 1D2

10B71D3

25A7v 19B3v 6C4 5C6

25B7v 19B3v 5A4 6C4

25B1v 19B3v 6C3 6A7

6C45B619B3v25B7v

5B26D3
19C3v

25B7v

5C3
19C3v25A1v

5A5
19C3v25A1v

5C3
19B3v25A1v

6C45B619C3v
25B7v

19B3v
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VCC1

OSC

GND OUT

SINGLE 50 PIN

FOR CONNECTION TO ETHERNET CARD
USED ON BOTTOM OF MOTHERBOARD

CONNECTORS
ETHERNET (LAN)

I.M. CARD PLUG-CONNECTORS

HIERARCHY BLOCK
_phy_imbus_mb_dn

PHY_INT

OSC25M

MDC

MDIO

PT2_TX_EN

PT2_RX_CLK

PT2_COL_DET

PT1_TX_EN

PT1_TX_CLK

PT1_TXD<3..0>

PT1_RX_ERR

PT1_RX_CRS

PT1_RXDV

PT1_RX_CLK

PT1_COL_DET

PT1_RXD<3..0>

GMII_TX_ER_
GMII_CLKTOMAC_BUF

SPARE

GMII_CLKFROM_MAC

RESET_B

PT2_TX_CLK

PT2_TXD<3..0>

PT2_RX_ERR

PT2_RX_CRS

PT2_RXDV

PT2_RXD<3..0>

LAN_CLK

V3_3

G
M

II
O

N
L

Y

_phy_dp83865bvh_dn
HIERARCHY BLOCK

SPARE<4..1>

CLKTOMAC_TESTPNT
CLKTOMAC

GMII_CLKFROM_MAC

COL_DET

RX_ERR

PHY_INT

RXD<7..0>

TXD<7..0>

RXDV

RX_CLK

RX_CRS

TX_CLK

TX_EN

TX_ER_

RESET_B

MDIO
MDC

PHYOSC25M

LAN_CLK

2

65

43

1

CONN_6P_U

VCC1

OSC

GND OUT

VCC1

OSC

GND OUT

V3_3

V3_3

D
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FOR DDR

11 DDR_BA0

DDR_BA1

DDR_CAS

DDR_RAS

DDR_WE

DDR_CKE

DDR_CK

DDR_CS

DDR_CKINV

DDR_LDM

DDR_UDM

DDR_LDQS

DDR_UDQS

DDR_DQ<15..0>

DDR_DQ<15..0>

DDR_VREF

DDR_A<12..0>

DDR_VREF

4
.7

U
F

4
.7

U
F

.1
U

F

.1
U

F

.1
U

F

.1
U

F

4
.7

U
F

4
.7

U
F

12

10

9

8

7

6

5

4

3

2

1

0

0

1

2

3

5

4

6

7

8

9

10

11

12

14

13

15

1.
00

K
1.

00
K

.0
1U

F
.0

1U
F

4
.7

U
F

4
.7

U
F

0

1

2

3

4

5

6

7

8

9

10

11

12

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

DDR_CS

DDR_CK

DDR_LDM

DDR_CKE

DDR_CKINV

DDR_CAS

DDR_BA0

DDR_BA1

DDR_RAS

DDR_WE

DDR_UDM

DDR_UDQS

DDR_LDQS

.0
1U

F

.1
U

F

4
.7

U
F

C
B

75
C

B
76

C
B

72
C

08

R
B

12
R

B
13

U06

29

28

41

42

30

31

32

35

36

37

38

39

40

26

27

22

45

46

44

24

5019

2

57

59

60

62

63

65

4

5

7

8

10

11

13

54

56

20

16

174314 2553

23

47

51

118 33 55 315 9 61 49

6648 34526458 12

6

21

C
B

58

C
B

1
0
2

C
B

49

C
B

90

C
B

83

C
B

85

C
B

1
4
6

C
B

89

C
B

74

C
B

1
1
0

C
B

63

U05

D12

C13

D13

C14

A14

B13

A13

A12

B11

C12

A11

B10

C11

D11

D9

B9

A9

A10

D10 C3

C4

D4

C5

D5

C6

D6

D7

A7

B6

A6

A5

B5

B4

A4

A3

B8

C7

C10

A8

B7

C9

B12

DDR_A<12..0>

10/03/2007

7/26(TOTAL)

7/12(BLOCK)

CR-7 : @\_RC_LIB\.\_RC_TOP_DN_\(SCH_1):PAGE7

DS33M33DK01A0

STEVE SCULLY

DDR MEMORY. P.7

BLOCK NAME: _rc_top_dn_.

7B8

7B8

7B8

7B8

7B8

7B8

7B8

7B8

7B8

7B8

7A8

7C5

7C5

7A4

7A1

7C4

10B3 7D2

7C8

10B37D5

7C3

7C3

7C3

7C3

7C3

7C3

7B3

7C3

7C3

7C3

7C3

7C1

7C1
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SDRAM I/F

DS33M33_U

SDUDM

SDWE*

SDRAS*

SDBA[1]

SDBA[0]

SDA[1]

SDA[0]

SDA[4]

SDA[3]

SDA[2]

SDA[6]

SDA[5]

SDA[9]

SDA[7]

SDA[8]

SDA[11]

SDA[10]

SDA[12]

SDCAS*

SDCLKN

SDCLKEN

SDLDM

SDCLKP

SDCS* SDDQ[0]

SDDQ[2]

SDDQ[1]

SDDQ[3]

SDDQ[5]

SDDQ[4]

SDDQ[6]

SDDQ[7]

SDDQ[8]

SDDQ[9]

SDDQ[10]

SDDQ[11]

SDDQ[12]

SDDQ[13]

SDDQ[14]

SDDQ[15]

SDUDQS

SDLDQS

V2_5

MT46V16M16BG75

A8

A9

A10/AP

A11

A12

A1

A2

A3

A4

A5

A6

A7

BA0

BA1

CAS

RAS

WE

CKE

CK

CS

CK_INV

LDM

UDM

D
N

U
D

N
U

N
C

N
C

N
C

N
C

N
C

V
S

S
Q

V
S

S
Q

V
S

S
Q

V
S

S
Q

V
S

S
Q

V
S

S
V

S
S

V
S

S

V
D

D
V

D
D

V
D

D

V
D

D
Q

V
D

D
Q

V
D

D
Q

V
D

D
Q

V
D

D
Q

V
R

E
F

A0

DQ0

DQ1

DQ3

DQ2

DQ6

DQ4

DQ5

DQ7

DQ8

DQ9

DQ11

DQ10

DQ13

DQ14

DQ12

LDQS

DQ15

UDQS

V2_5

V2_5
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REMOVE THIS INVERTER TO MAKE USE OF THE JUMPER OPTIONS FOR ALE (ABOVE)

AS TESTPOINTS FOR PROTO BOARD (NOT NEEDED)

INSTANTIATE PULLUP FOR INT IN FPGA

MT0 & MT2 ATTACED TO RPACK

DOUBLE CHECK BIAS NEEDS FOR MT1

ALE SHOULD BE TIED HIGH FOR NON-MULTIPLEXED ADDRESS

OPERATION AND TIED TIED LOW DURING SPI MODE (SPISEL=1).

M3X_JTMS

CS_X1

M3X_CS

JMP_3

13

M3X_CS

D2_SPI_CLK

DATA<7..0>

SPI_SS

2

JMP_3

INVERTER

M3X_INT

M3X_INT

RD_DS

13

WR_RW

5

1K

10K

1

DATA<7..0>

D7_SPI_CPOL

DATA<7..0>

DATA<7..0> D0_SPI_MISO
SPI_SCK

7

6

5

1

0

JMP_3

10K

330

1K

10K

4

2

8

6

10

12

0

3

5

7

9

11

ADDR<13..0>

43

1

10

12

0

14

7

9

11

15

DATA<15..0>

2

8

6

D5_SPI_SWAP

10K

1K
D6_SPI_CPHA

M3X_MT0

M3X_MT1

M3X_MT2

M3X_ALE

M3X_RMIISEL

M3X_DCESEL

M3X_HIZ_N

M3X_SPISEL
M3X_TEST_EN

M3X_IFSEL_STYLE

M3X_IFSEL_SIZE

M3X_JTRST_N

M3X_SPISEL M3X_ALE

M3X_JTDI

M3X_JTDO

SPI_MISO

JMP_3

DATA<7..0>

D1_SPI_MOSI

SPI_MOSI

DATA<7..0>

1K M3X_JTCLK

RPB50

4

3

2

1

5

6

7

8

J30

1 2

3 4

5 6

7 8

9 10

11 12

13 14

RPB52

4

3

2

1

5

6

7

8
RPB53

4

3

2

1

5

6

7

8

DS28

J16

12

34

56

78

910

RPB32

4

3

2

1

5

6

7

8

JP
11

1
3

2

JP
14

1
3

2

JP
13

1
3

2

JP
12

1
3

2

RPB36

4

3

2

1

5

6

7

8

JP
22

1
3

2

JP
21

1
3

2

JP
20

1
3

2

RPB33

4

3

2

1

5

6

7

8

UB05
1 4

RPB49

4

3

2

1

5

6

7

8RPB48

4

3

2

1

5

6

7

8

RPB29

4

3

2

1

5

6

7

8

J24

1 2

3 4

5 6

7 8

9 10

11 12

13 14

J21

1 2

3 4

5 6

7 8

9 10

11 12

13 14

15 16

J23

1 2

3 4

5 6

7 8

9 10

BIAS+CONFIG. P.8

CR-8 : @\_RC_LIB\.\_RC_TOP_DN_\(SCH_1):PAGE8

8/26(TOTAL)

8/12(BLOCK)

DS33M33DK01A0

STEVE SCULLY

10/03/2007

BLOCK NAME: _rc_top_dn_.

8C21A8

1D3 1A8 8D3

1B5

8D4 8C6

1D38C1

1D3 1B8 8A8

9C1 10B5 1A8 1D3

9C1 10B5 1A8 1D3

1B19C310B51A88B38C6
8D3

1B19C310B51A88B38D38D48D6

1B1

1B19C310B51A88B38C68D3
8D6

9C310B51A88B38C6
8D38D48D6

1B19C310B51A88B38C68D38D48D6

1B19C31A8
8B3

1C1

1A5

1A29C110B51A8

1B19C310B51A88C68D38D48D6

1C1

1C1

1B5

1B5

1B5

8A21A8
1D3

5A4

1B5

1C5

8A21B5 8B2 1A8 1D3

1C5

1D3

1A5

10B5
8D6

1B5

8D6 8D4

1C1

1C1

1C5

1C5

1C5

1B8

8D4

1B1
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V3_3

6

10

8

4

1 2

3

5

7

9

CONN_10PCONN_16P

2

4

8

10

12

14

16

3

1

7

9

11

13

15

5 6

V3_3

2

3

7

13

8

5

9

11

6

4

10

12

14

1

CONN_14P

V3_3

V3_3

NC7SZ86_U

V3_3

V3_3

2

3

7

13

8

5

9

11

6

4

10

12

14

1

CONN_14P

V3_3

CONN_10P

5

3

1

7

TMS

TCK

TDI

TDO

VCC GND
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DATABUS TAPS WRONG [0:7]
THIS HAS BEEN FIXED IN THE FPGA.

BUG FIX:
PCB REV 01A0 HAD THE

PLACE TESTPOINTS TO ALLOW LOOPBAK T--R
PORT / PIN ASSIGNMENTS
DS33M33_RCLK1 IS AT PIN F3

DS33M33_RCLK3 IS AT PIN J2
DS33M33_RCLK2 IS AT PIN H3

M33_TNEG3

M33_TPOS3

DATA[7..0] TE3_INT

WR_RW
RD_DS

330

M33_TPOS1

M33_TCLK2

M33_TPOS2

ADDR[5..0]

RESET_SYS

5
4
3
2
1

330

M33_TNEG3

M33_RCLK3

M33_RNEG3

M33_TCLK3

M33_RPOS3 M33_TPOS3

M33_GPIOB3

M33_GPIOA3

M33_RCLK2

M33_RNEG2

M33_TCLK2

M33_RPOS2

M33_GPIOB2

M33_GPIOA2

M33_RCLK1

M33_RNEG1

M33_TCLK1

M33_RPOS1 M33_TPOS1

M33_GPIOB1

M33_GPIOA1

M33_TNEG1

M33_TNEG1

M33_TCLK1

M33_RNEG1

M33_RCLK1

M33_RPOS1

M33_RNEG2

M33_RCLK2

M33_RPOS2

M33_RNEG3

M33_RCLK3

M33_RPOS3

M33_TNEG2

1K

1K

10K

10K

M
3
X

_
C

L
K

A

RED_GREEN

M33_GPIOB1

M33_GPIOA1

M33_GPIOA3

M33_GPIOB3

M33_GPIOA2

M33_GPIOB2

M33_TCLK3

0
1
2
3
4
5
6
7

M33_TNEG2

M33_TPOS2

M
3
X

_
C

L
K

B

TE3_L_CS

0

M3X_CLADCLK_TO_LIU

RED_GREEN

RED_GREEN

J12

1 2

3 4

5 6

J14

1 2

3 4

5 6

J17

1 2

3 4

5 6

J18

1 2

3 4

5 6

J15

1 2

3 4

5 6

J13

1 2

3 4

5 6

U05

G2

F2

F3

G4

E2

E3

F4

D2

U05

L4

K3

J2

K4

J3

J4

J5

K5

U05

H5

J6

H3

H4

H2

G3

H6

G5

RPB05

4

3

2

1

5

6

7

8

RPB02

4

3

2

1

5

6

7

8

DS07

1

2

3

4

DS06
1

2

3

4

DS01

1

2

3

4

RPB07

4

3

2

1

5

6

7

8

RPB04

4

3

2

1

5

6

7

8

J01

1 2

3 4

5 6

7 8

9 10

11 12

13 14

RPB13

4

3

2

1

5

6

7

8

RPB08

4

3

2

1

5

6

7

8

9/26(TOTAL)

CR-26 : @\_RC_LIB\.\_RC_TOP_DN_\(SCH_1):PAGE1_I9@\_RC_LIB\.\_DS33M30DK_DN_\(SCH_1):PAGE7

04/15/2007

9/12(BLOCK)

CR-9 : @\_RC_LIB\.\_RC_TOP_DN_\(SCH_1):PAGE9

STEVE SCULLY

DS33M30M31M33EE01A0

T3E3 LIU I/F. P.2,9,20-22

BLOCK NAME: _rc_top_dn_.

9A6

9A6

21D7v21D3v21C8v
21C7v21C3v21C2v8D68D48D38C68B31A810B51B1

20D8v1B8

21C8v1D31A810B58C1

21C4v1D31A810B58C1

9D6

9C6

9B6

21D6v21D2v

21C6v21C3v21C2v
8B51A810B51A2

20B5v1B51A811B310B4

9C4

9C1

9C1

9C4

9C1 9C4

10C49A5

10C49A5

9D1

9D1

9D4

9C1

10C49A5

10C49A5

9D1

9D1

9D4

9D1 9D4

10C49A5

10C49A5

9D4

9D6

9D6

9D8

9D8

9D8

9C8

9C8

9B8

9A8

9A8

9A8

9C6

20A3v10B71D3

9A6

9D4

9C4

20A2v10B7
1D2

21C4v1A8

20A5v6C6
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2

3

7

13

8

5

9

11

6

4

10

12

14

1

CONN_14P

2

13

4

2

13

4

2

13

4

V3_3

DS33M33_U

PORTRLCLK

RNEG/RLCV

TLCLK

RPOS/RDAT TPOS/TDAT

GPIOB

GPIOA

TNEG

DS33M33_U

PORTRLCLK

RNEG/RLCV

TLCLK

RPOS/RDAT TPOS/TDAT

GPIOB

GPIOA

TNEG

DS33M33_U

PORTRLCLK

RNEG/RLCV

TLCLK

RPOS/RDAT TPOS/TDAT

GPIOB

GPIOA

TNEG

2

65

43

1

CONN_6P_U

2

65

43

1

CONN_6P_U

2

65

43

1

CONN_6P_U

2

65

43

1

CONN_6P_U

2

65

43

1

CONN_6P_U

2

65

43

1

CONN_6P_U

_ds3154_liublock_dn

HIERARCHY BLOCK

ADDR0

DATA7
DATA6
DATA5
DATA4
DATA3
DATA2
DATA1
DATA0

LIU_TPOS1

LIU_TNEG1

E
3
_
M

C
L
K

_
IO

T
3
_
M

C
L
K

_
IO

A
L
T

E
R

N
A

T
E

_
M

C
L
K

RST
INT

RD_DS
CS

LIU_TCLK1

ADDR2
ADDR1

LIU_RPOS3

LIU_RNEG3

ADDR3

LIU_TNEG3

LIU_TCLK3

LIU_TPOS3

LIU_RCLK3

LIU_TPOS2

LIU_TCLK2

LIU_TNEG2

LIU_RPOS2

LIU_RCLK2

LIU_RNEG2

LIU_RPOS1

LIU_RCLK1

LIU_RNEG1

WR_RW

ADDR4
ADDR5
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M33_GPIOA3

M3X_CLKC

M3X_CLKB

M3X_CLKA

M3X_CLADCLK
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PLACE PADS FOR CAP

VDD IS A
(UNUSED) OUTPUT

USE RPACK

TESTPOINTS

ON CP2101 CHIP

ALIGN KEY

UART_DIGOUT

PRT1_IN

PRT1_OUT

PRT1_IN

PRT1_OUT

UART_DIGIN

PROCSER_OUT

UART_DIGOUT

USB_DIN

USB_DOUT

SSPL

USB_DOUT

SSPL

USB_DIN

10K

1U
F

10K

10K

CON14P

ONCE_TRST_B

330

ONCE_TMS

ONCE_TDI

2107_TDO

RESET_IN

FLASH_VPP

ONCE_TCLK

1.
0M

8.0MHZ

OSC_MCU

XTAL

GREEN
KIT_STATUS

10K

ONCE_DE_B

USB

PROCSER_IN

.1
U

F

4
.7

U
F

10
K

UART_DIGIN

J33

1 2

3 4

5 6

7 8

9 10

11 12

13 14

UB14

13

14

15

16

10

5

18

2

8

6

201

4

7

3

19

11

12

17

9

J34

1

2

3

4

5

6

7

8

9

R
03

1

2
1

XB01

2
1

JB08
2 1

RPB64

4

3

2

1

5

6

7

8

RPB63

4

3

2

1

5

6

7

8

RB26
1

2 1

DS29

1 2

RPB58

4

3

2

1

5

6

7

8

RPB60

4

3

2

1

5

6

7

8

U10
23

1

27

28

3

10

21

22

13 14 15 16 17

18

19

20

7

29

24

25

12

11

26

5

4

8

6

C
B

1
8
4

1
2

C
B

17
7

1
2

C
B

1
7
8

1
2

R
B

29

1
2

J35

1
2
3
4

5

JP25

1
3

2

JP26

1
3

2

3/6(BLOCK)
15/26(TOTAL)

DS33M33DK01A0

BLOCK NAME: _motprocrescard_dn. PARENT BLOCK: \_rc_top_dn_\

10/03/2007

CR-15 : @\_RC_LIB\.\_RC_TOP_DN_\(SCH_1):PAGE2_I10@\_RC_LIB\.\_MOTPROCRESCARD_DN\(SCH_1):PAGE3

STEVE SCULLY

MICROPORT. P.1,13-18

15A5

15A8

15A8

15B8

15B8

15A5

16B5 13B8

15B8

15B2

15B2

15B2

15A5

15B4

15B5

13A6

13A6

13D6

13D6

1A8^ 18C2 14D1 13B5

13A6

13A6

13A7

17C7 13A7

13B5

16B5 13B8

15B8

PAGE:

DATE:TITLE:

ENGINEER:

A A

B B

C C

D
D

1

12

23

34

45

56

67

78

8

CP2101

USBDM

SUSPEND_LOW*

SUSPEND_HIGH

RXD

TXD

V
D

D

G
N

D

N
C

1

N
C

2

N
C

3

N
C

5

N
C

4

N
C

6

REGIN

RST*

NC11

NC10

NC9

NC8

NC7

RI*

DCD*

DSR*

CTS*

DTR*

RTS*

USBDP

VBUS

V3_3

V5_0

V3_3 V3_3

CONN_DB9P

H

G

F

C

A

B

D

E
J

MAX3233E

INVALID*

T2IN

T2OUT

GND

V-

C2-

C2+

C1-

C1+

V+2

V+1FORCEOFF*

VCC

T1OUT

R1OUT

FORCEON

T1IN

R1IN

R2OUT R2IN

V3_3

GND

DAT-
VDD

DAT+U
S

B

CON14P

D
ow

nloaded from
: http://w

w
w

.datasheetcatalog.com
/

http://www.datasheetcatalog.com/
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PROGRAMN

INITN

SPICLK CCLK

DONE

PR24A MISO (BUSY/SISPI)

PR24B (DOUT/CSON)

XRES

V3_3

MAX1963

SHDN*

GND RST*

OUT

IC

IN

V3_3

AT25160A_U

SI

GND

WP*

HOLD*

VCC

SO

SCK

CS*

CONN_10P

7

1

5

GND

3 TCK

TMS

TDI

VCC
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CONNECTORS FOR LAN MOTHERBOARD TO RESOURCE CARD

BEGIN/END PHY CONNECTOR HIERARCHY BLOCK

PHY_INT

PT2_TX_CLK

SFM-125-L2-S-D-LC

GMII_CLKTOMAC_BUF

LAN_CLK

MDC

RESET_B

MDIO

PT2_TX_CLK

PT2_TX_EN

PT2_TX_EN

NA
I130

PT1_TXD<3..0>

PT1_RXDV

PT1_RX_ERR

PT1_COL_DET

3

LAN_CLK

PT1_RX_CRS
PT1_RX_CRS

MDIO

V3_3

GND

GMII_TX_ER_

PT1_RXD<3..0>

PT2_TXD<3..0>

PT2_TX_CLK

PT2_RX_CLK

PT2_COL_DET

PT2_RX_ERR

PT2_RX_CRS

PT2_RXD<3..0>

PT2_RXDV

PT1_RXDV

PT1_TXD<3..0>

PT1_TX_EN

PT1_TX_CLK

PT1_RX_CLK

PT1_COL_DET

PT1_RX_ERR

PT1_RX_CRS

I67

I68

GMII_CLKFROM_MAC

SPARE GMII_CLKTOMAC_BUF

0

1

2

3

0

1

2

3

0

1

2

0

1

2

3

NA

SMT

I78

PT1_RXD<3..0>

PT1_TXD<3..0>

PT2_RXD<3..0>

PT2_TXD<3..0>

PT1_TX_CLK

PT1_TX_EN

GMII_TX_ER_

OSC25M

PT2_TX_EN

MDIO

MDC

PT1_RX_CLK

PHY_INT

SPARE

PT2_RX_CRS

PT2_RX_CLK

PT2_COL_DET

PT2_RX_ERR

LAN_CLK

PT1_COL_DET

PT2_RXDV

PT1_RX_ERRGMII_CLKFROM_MAC

RESET_B
0

1

2

3

0

1

2

3

0

1

2

3

0

1

2

3

SMTTP
NA_NOTPOPULATED

PT1_RXD<3..0>

PT2_TXD<3..0>

PT1_TX_CLK

PT1_TX_EN

GMII_TX_ER_

GMII_CLKTOMAC_BUF

OSC25M

MDC

PT1_RX_CLK

PHY_INT

SPARE

PT2_RX_CRS

PT2_RX_CLK

PT2_COL_DET

PT2_RX_ERR

PT2_RXDV

PT1_RXDV

GMII_CLKFROM_MAC

RESET_B

6B1^19B819B4

6B1^19B819B4

19B6 19B2 6B1^19B819B4

6B3^ 19B4

6B3^ 19B8

PT2_RXD<3..0>

JB03

1

23 24

25 26

27 28

29 30

31 32

33 34

35 36

37 38

39 40

41 42

43 44

2

45 46

47 48

49 50

3 4

5 6

7 8

9 10

11 12

13 14

15 16

17 18

19 20

21 22

JB02

1

23 24

25 26

27 28

29 30

31 32

33 34

35 36

37 38

39 40

41 42

43 44

2

45 46

47 48

49 50

3 4

5 6

7 8

9 10

11 12

13 14

15 16

17 18

19 20

21 22

BLOCK NAME: _phy_imbus_mb_dn. PARENT BLOCK: \_rc_top_dn_\

1/1(BLOCK)

10/03/2007

DS33M33DK01A0

19/26(TOTAL)

CR-45 : @\_rc_lib\.\_rc_top_dn_\(sch_1):page5_i3@\_rc_lib\.\_phy_imbus_mb_dn\(sch_1):Page1

STEVE SCULLY

ETHERNET. P.5-6,19,25-26

19C1 19A4

6B1^ 19B4 19A4

6B3^ 19A8

19C1 19A8

19C1 19B8

6C3^19B619B1

6C3^ 19C8 19D1

6D3^19C219C1

6C3^19D119B6

6D3^19D119C6

6B3^ 19B8 19A8

6D3^19D119C6

6D3^19D119C2

6D3^19C219C1

6C3^ 19C4 19D1

6C3^19B219B1

6C3^ 19B4 19C1

6C3^ 19D1 19C4

6C3^ 19D1 19C4

6B1^ 19B4 19A4

19C1 19B4

6B3^ 19A8 19A4

6B3^ 19A8 19A4

6D3^19D119C2

6B3^19B219A8

19B219A7

19C119B2

19C119A2

19C119A2

19C119A2

6B3^ 19B4 19A8

6D3^19D119C2

19C119B2

6C3^19D119B26B1^ 19B4 19A4

6B3^ 19C4 19A8

6D3^19C619C1

6C3^ 19B8 19C1

6C3^ 19D1 19C8

6C3^ 19D1 19C8

6B1^ 19B8 19A4

6B1^ 19B8 19A4

6B3^ 19A8

6D3^19D119C6

6B3^19B619A8

19B619A7

19B6

19C119A6

19C119A6

19C119A6

19B6

6D3^19C619C1

6B1^ 19B8 19A4

6B3^ 19C7 19A8

19C1

19C1
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ENGINEER:

A A

B B

C C

D
D

1

12

23

34

45

56

67

78

8

V2_5

IO

V3_3

V1_8

IO

5049

4847

4645

4443

4241

4039

3837

3635

3433

3231

3029

2827

2423

2221

17

11

7

4

25 26

2019

9

1

8

16

12

10

2

14

3

65

18

15

13

IO

IO

IO

IO

IO

IO

V3_3

IO

IO

IO

IO

IO

IO

IO

IO

IO

IO

IO

IO

IO

V2_5

IO

IO
V3_3

V1_8

5049

4847

4645

4443

4241

4039

3837

3635

3433

3231

3029

2827

2423

2221

17

11

7

4

25 26

2019

9

1

8

16

12

10

2

14

3

65

18

15

13

IO

IO

IO

IO

IO

IO
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DS3254 OR

ALTERNATE_MCLK:
REG CACR[AMCSEL1:0]=00 FOR 19.44MHZ
REG CACR[AMCSEL1:0]=10 FOR 77.76MHZ

BEGIN LIU HIERARCHY BLOCK

RST

LIU_ALT_MCLK

LIU_E3MCLK

44.736MHZ_3.3V

34.368MHZ_5.0V

.1
U

F

4
.7

U
F

T3OSC

LIU_T3MCLK

E3_MCLK_IO

E3OSC

LIU_ALT_MCLK

LIU_T3MCLK

LIU_E3MCLK

LUI_HW

10K

330

RED

E3OSC

30

1UH

JTRST

10K

LIU_TEST

JTDO

JTRST

JTDO

JTDI

OSCSEL

JTDI

JTMS

JTMS

JTCLK

LIU_T3MCLK

.1
U

F

T3OSC

4
.7

U
F

LIU_E3MCLK

ALE

MOT

LUI_HW

RST

INT

LIU_TEST

JTCLK

OSCSEL

LIU_ALT_MCLK

ALTERNATE_MCLK

9B3^ 9B3^

9B3^

T3_MCLK_IO

U07

E12

J8

E9

E4

H4

J4

D5

D4

B3

C11

K2

L10

D9

J9

H1

M8

A5

D8

H9

J5

D
6

H
7

H
8

J7E
5

E
6

F
4

F
5

F
6

G
7

G
8

G
9

D
7

H
5

H
6

J6E
7

E
8

F
7

F
8

F
9

G
5

G
4

G
6

DS19

1 2

YB03

4 5

1 8

YB04

4 5

1 8

L02

C
10

C
09

C
07

C
14

JP15

1
3

2

JP18

1
3

2

JP19

1
3

2
JP17

1
3

2

RP09

4

3

2

1

5

6

7

8

RPB40

4

3

2

1

5

6

7

8

J32

1 2

3 4

5 6

7 8

9 10

RPB55

4

3

2

1

5

6

7

8

RPB38

4

3

2

1

5

6

7

8

BLOCK NAME: _ds3154_liublock_dn. PARENT BLOCK: \_rc_top_dn_\

DS33M33DK01A0

20/26(TOTAL)STEVE SCULLY

10/03/2007

1/3(BLOCK)

CR-46 : @\_rc_lib\.\_rc_top_dn_\(sch_1):page13_i204@\_rc_lib\.\_ds3154_liublock_dn\(sch_1):Page1

T3E3 LIU I/F. P.2,9,20-22

46B6 47A6 10B2^

47A647D8
10B2^

9B2^ 21A6 20C7

20C8 20A4

20C820B6

20A7

20C820C6

20A7

20B6 20A4

20C6 20A3

20B6 20A1

20B6

20A1

20C3

20B3

20B2

20A2

20B3

20B3

21B721B521B421B220A4

20B2

20C4

20B2

20B2

20C8 20A3

20A3

20C8 20A1

21C4

21D3

20C8

20B6

20B4

21B721B521B421B220A6

20C820B6
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CONTROL
DS3154

V
D

D
1

2

V
D

D
2

V
D

D
1

V
S

S
1

V
S

S
2

V
S

S
3

V
S

S
4

V
S

S
5

V
S

S
6

V
S

S
7

V
S

S
8

V
S

S
9

V
S

S
1

0

V
S

S
11

V
S

S
1

2

V
D

D
11

V
D

D
1

0

V
D

D
9

V
D

D
8

V
D

D
7

V
D

D
6

V
D

D
5

V
D

D
4

V
D

D
3

JTMS

JTCLK

JTDI

JTDO

HIZ

NC1

NC2

NC3

NC4

T3MCLK

E3MCLK

RST*

TCINV

TEST*

RCINV

STMCLK

TBIN

HW

RBIN

JTRST*

V3_3

V3_3

V3_3

OUT

V3_3

1

VCC

5

TDI

CONN_10P

GND

TDO

TMS

TCK

3

RST

IO IO

IN

IO

V3_3

VCC1

OSC

GND OUT

VCC1

OSC

GND OUT
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DS3254 OR

PORT LOCATIONS
RLOS1 IS AT PIN A1
RLOS2 IS AT PIN M12

IT IS A SPARE PORT IN THIS DESIGN

DS3254 OR

DS3253 IS RECOMMENDED FOR DS33M33

PORT 4 OF DS3254 IS NOT USED WITH DS33M33

DS3254 OR

RLOS3 IS AT PIN A12

DS3254 OR

LIU_RPOS4

LIU_RCLK3

LIU_TCLK3

DATA6

DATA4

RCLK2

RXP2

RCLK1

RPOS1

RNEG4

LIU_TCLK4

ADDR5

ADDR5

RXN2

LIU_TPOS2

LIU_TNEG2

RTS2

ADDR4

RCLK2

TXP2

TXN2

TDM2

TTS2

PRBS2

LIU_TCLK2

RNEG2

RPOS2

RLOS2

TXP1

TXN1

RST

LIU_RNEG3

LIU_RPOS3

LIU_RCLK3

LIU_RCLK4

LIU_TCLK4

LIU_RCLK4

CS

INT

RCLK1

RNEG1

DATA0

LIU_TCLK1

DATA3

30

OSCSEL

RXN3

RCLK3

RPOS3

RNEG3

JMP_3JMP_3

RCLK4

LIU_TCLK3

RLOS3

RPOS3

RNEG3

ALEDATA2

RXP1

RXN1

PRBS3

ADDR2

DATA7

DATA6

DATA1

RTS1

RLOS1

RPOS1

TXP3

TDM1

LIU_TPOS1

LIU_RCLK1

LIU_TPOS4

LIU_TNEG4

TDM3

TTS1

RCLK3

TTS3

JMP_3

RPOS4 30

OSCSEL

30

LIU_RNEG1

LIU_RPOS1

RNEG1

PRBS1

RXP3

MOT

TXP4

TTS4

PRBS4

RPOS4

RLOS4

LIU_RCLK1

LIU_TPOS3

LIU_TNEG3

TXN3

RTS3

LIU_TNEG1

OSCSEL

RNEG4 LIU_RNEG4

LIU_RPOS4

LIU_RCLK4

TXN4

RCLK4

DATA4

TDM4

ADDR3

RTS4

ADDR1

RXP4

RXN4

DATA5

ADDR0

JMP_3

RD_DSCS

WR_RW

OSCSEL

LIU_TCLK2

ADDR2

ADDR3

ADDR4

DATA0

DATA1

DATA2

DATA3

DATA7

DATA5

RD_DS

LIU_TCLK1

INT

LIU_RCLK2

LIU_TNEG4

LIU_TCLK4

LIU_TPOS4

LIU_RNEG4

WR_RW

ADDR1

ADDR0

30

LIU_RNEG2

RPOS2

RNEG2

LIU_RCLK2

LIU_RPOS2

9C3^21D3

9C3^21D7

9C3^21D7

9C3^21C8

9C3^21C8

9C3^21C7

9C3^21C2

9C3^21C3

U07

K6

H2

M2

M3

J2

H3

M1

J1

K3

L3

L2

L1

K1

L6

M5

K4

L7

K7

J3

K5

L4

M4

L5

M7

M6

U07

C7

E11

A11

A10

D11

E10

A12

D12

C10

B10

B11

B12

C12

B7

A8

C9

B6

C6

D10

C8

B9

A9

B8

A6

A7

U07

G10

L8

L12

K12

L9

K8

M12

M9

K10

K11

L11

M11

M10

G11

H12

J10

F11

F10

K9

H10

J11

J12

H11

F12

G12

U07

F3

B5

B1

C1

B4

C5

A1

A4

C3

C2

B2

A2

A3

F2

E1

D3

G2

G3

C4

E3

D2

D1

E2

G1

F1

JPB01

1
3

2JP23

1
3

2
JP24

1
3

2
JP16

1
3

2

RPB35

4

3

2

1

5

6

7

8 RPB37

4

3

2

1

5

6

7

8 RPB31

4

3

2

1

5

6

7

8 RPB44

4

3

2

1

5

6

7

8

JB07

1 2

3 4

5 6

21/26(TOTAL)

2/3(BLOCK)

10/03/2007

BLOCK NAME: _ds3154_liublock_dn. PARENT BLOCK: \_rc_top_dn_\

DS33M33DK01A0

CR-47 : @\_rc_lib\.\_rc_top_dn_\(sch_1):page13_i204@\_rc_lib\.\_ds3154_liublock_dn\(sch_1):Page2

STEVE SCULLY

T3E3 LIU I/F. P.2,9,20-22

47B7 47B5
47B4

47B447B547B7

47C310C2^

47C310C2^

47D210C2^

47C210C2^

47D610C2^ 47C8 10C2^

47C3 10C2^

47C4 10C2^

46B6 46C7 10B2^

46D8 47D8 10B2^

47C610C2^

21B2

21B3

21C3

21C6

22A5

21C8

21D8

21B221A4

9C2^ 21A8

22A5

22D8

9C2^
21A8

22B5

22B5

22A7

22C8

22C822B7

22D5

22D5

21B2

21C121A4

21B221A3

9B2^ 21A6 20D8

21B8

21B8

9C3^21A8

21B521B421B220A620A4

22C3

21C4

21D4

21D4

21C3

22B7

21B4

21B4

20D89C3^ 21A8

22C5

22C5

22B8

9C2^21A8

9C3^21A8

9C3^ 21A8

9C3^ 21A8

22D8

22B7

21B8

22D3

21B7

21A4

21A4

22A7

22C8 22C8

21D3

21B721B521B220A620A4

21D8

22C8

22C3

20D8

22B3

22C8

22B822B7

22D3

22C8

21B721B521B420A620A4

21D3 21A3

21A3

21B221A3

22B3

9C3^21A8

22A7

9C2^21A8

22C8

9C2^ 21A8

22A3

22A3

9C3^ 21A8

9C2^ 21A8

9C2^ 21A6

9C2^ 21A6

21B721B421B220A620A4

21C5
21C6

21B5

21D1

21C1 21B2

21D1

21B2

21D6

21D6
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IN

OUT

IN

DS3154
PORT

TPOS

TNEG

RJA

RTS*

RMON

RLB

RCLK

STS

LLB

E3M

RXP

RXN

TXP

TXN

TDM*

TDSA

TDSB

TJA

TTS*

PRBS

TLBO

TCLK

RNEG

RPOS

RLOS*

IN

IN

INIO

IO

IO

IO

IO

IO

DS3154
PORT

TPOS

TNEG

RJA

RTS*

RMON

RLB

RCLK

STS

LLB

E3M

RXP

RXN

TXP

TXN

TDM*

TDSA

TDSB

TJA

TTS*

PRBS

TLBO

TCLK

RNEG

RPOS

RLOS*

IO

IN

IN

IN

IN

IN

IO

2

65

43

1

CONN_6P_U

IN

IN

DS3154
PORT

TPOS

TNEG

RJA

RTS*

RMON

RLB

RCLK

STS

LLB

E3M

RXP

RXN

TXP

TXN

TDM*

TDSA

TDSB

TJA

TTS*

PRBS

TLBO

TCLK

RNEG

RPOS

RLOS*

IN IN

IN

IN IN

IN

IN

OUT

OUT

OUT

OUT

OUT

OUT

OUT

OUT

OUT

DS3154
PORT

TPOS

TNEG

RJA

RTS*

RMON

RLB

RCLK

STS

LLB

E3M

RXP

RXN

TXP

TXN

TDM*

TDSA

TDSB

TJA

TTS*

PRBS

TLBO

TCLK

RNEG

RPOS

RLOS*
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UNUSED PRBS SIGNALS
ACCESS POINTS FOR

END LIU HIERARCHY BLOCK

33
2

RXP1

RXP4RXP2

TXP2 TXP4

RXP3

TXP3

RLOS4

RLOS3

PRBS3

PRBS1

PRBS4

TTS3

TTS1

RTS3

10K

10K 330

330

10K

RED

RED

33
2

33
2

33
2

33
2

33
2

RXN3RXN1

TXN4

RXN4

TXN2

RXN2

33
2

TXN3

33
2

TXP1

TXN1

TTS4

RTS2

RTS4

TTS2

10K

RTS1

PRBS2

RLOS2

RLOS1

330

TDM4

TDM2

TDM1

TDM3

R
B

21
R

B
19

J27

2

1

R
B

23
R

B
17

R
B

24
R

B
20

R
B

25
R

B
22

RPB47

4

3

2

1

5

6

7

8

RPB43

4

3

2

1

5

6

7

8

RPB39

4

3

2

1

5

6

7

8

DS20
1 2 DS22

1 2 DS25

1 2 DS27

1 2

RPB42

4

3

2

1

5

6

7

8RPB41

4

3

2

1

5

6

7

8

DS21
1 2 DS23

1 2 DS24

1 2 DS26

1 2
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